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Introduction 
ASP’s ZipNet Anywhere is a 32-bit program designed to run under 
Microsoft Windows 98 or later operating systems, and is intended to 
operate with ASP’s ZipNet Terminals and TimeSheet Express Time 
and Attendance system. 
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Installing ZipNet Anywhere 
Floppy Disk Installation 
Insert the installation disk into a floppy disk drive. Then, press the 
Start button at the bottom left of the screen, select Run, type a:\setup 
(where a: is your floppy disk drive letter), then press the OK button and 
follow the on-screen instructions. 

CD Installation 
The installation program should start automatically when you insert the 
CD into your CD-ROM drive.  If it doesn’t, press the Start button at 
the bottom left of the screen, select Run, type d:\setup (where d: is 
your CD-ROM drive letter), then press the OK button and follow the 
on-screen instructions. 

We strongly suggest that you install the program into the folder that the 
installation program suggests. 

How ZipNet Anywhere works 
The ZipNet Anywhere polling program operates around the idea of 
units, locations, and schedules.  A Location consists of one or more 
Units, and locations are polled according to a Schedule. 

Units are individual ZipNet Terminals.  One or more units are 
connected by RS-485 cabling to an RS-485 Convertor, which is 
connected to the serial port of a PC, or to a modem. 

Locations can be Local, where ZipNet Terminals are attached to a 
serial port on the computer running the polling program, or Remote, 
where a modem is used to communicate with ZipNet Terminals that are 
attached to another modem at a separate site.  Each location can 
accommodate up to 31 ZipNet Terminals, and an unlimited number of 
locations can be defined. 

Schedules are used to control when ZipNet Anywhere polls locations.  
Scheduled polls can be periodical (for example, every two hours), or at 
specific times (ie at 9:15am).  More than one scheduled poll can be set 
for each location. 

Note that more than one location can refer to the same site – this would 
be useful, for example, if you wanted to poll different units at a site at 
different times. 
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Setting up ZipNet Anywhere 
Shown below is the main screen of the ZipNet Anywhere polling 
program.  At the top left of the screen, you’ll find the File, Insert and 
Help menus. 

Below these menus is the toolbar, which is a set of buttons with text and 
pictures.  The most frequently used functions can be accessed directly 
by clicking on the toolbar buttons. 

Below the toolbar is a set of tabs that allow access to the four main 
screens of the program.  The Locations tab is selected on the screen 
shown below, since that’s where we have to start. 

Before you can start using ZipNet Anywhere, you’ll first have to create 
one or more Locations, then define the units that are at those locations, 
then set polling schedules for the locations. 

The following pages tell you how to set up the various sections of the 
ZipNet Anywhere polling program. 
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Setting up Locations 
First, you need to define one or more Locations.  A Location is a 
number of ZipNet Terminals that you want to consider as a “block”, so 
that you can poll them all together.  If your workplace is spread over 
several physical sites, a Location could be one of those sites. 

Select the Locations tab to bring up the screen below: 

To define a location, you can either right click in the yellow section of 
this screen, then select Add Location, or select New Location from the 
Insert menu.  This will bring up the screen shown below. 

Locations must 
have names.  The 
Location Name 
can be set to 
anything you like, 
but it’s best to 
make it descriptive 
so that it’s obvious 
what it refers to. 

If you’re defining a 
Local location (ie 
where ZipNet 
Terminals are 
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attached to a serial port on this computer via an RS-485 adaptor, make 
sure you select Local in the Connection section of this screen. 

The Number of Retries and Number of Acknowledges in the Polling 
Options section of the screen should be left at their defaults of 3 – see 
later in this manual for a description of these options. 

In the Interface section, you need to set the COM Port (or Serial Port) 
that the RS-485 converter and ZipNet Terminals will be connected to.  
Note that only those serial ports that are properly installed and available 
for use are listed. 

If you’re defining a Remote location (ie where the ZipNet Terminals 
are located at a different site and will be polled via a modem), select 
Remote in the Connection section of this 
screen, and the Interface section of the 
screen will change as shown on the right. 

In this section of the screen, you need to 
select a Modem that will be used to dial the 
location, and the Phone Number of the 
telephone line attached to the modem at the 
remote site.  Note that only those modems 
that are properly installed and available for 
use are listed. 

The Number of Redials and the Time Between Redials should be left 
at their defaults of 3 – see later in this manual for a description of these 
options. 

Once you’ve finished defining a location, press the OK button to save 
the location, or press the Cancel button if you don’t want to save it.  
You can then define any other locations needed for your application as 
required. 
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Setting up Units 
Next, you need to define which units will be at the locations you’ve just 
set up.  Note that you must define the locations first – you can’t define a 
unit unless there are locations to attach that unit to. 

Select the Units tab to bring up the screen below: 

To define a unit, you can either right click in the yellow section of this 
screen, then select Add Unit, or select New Unit from the Insert menu.  
This will being up the 
screen on the right: 

The first thing you 
need to do is to give 
this unit a name.  
Again, the Unit Name 
can be anything you 
like, but it’s best to 
make it descriptive so 
that it’s obvious which 
unit it refers to.  Next, 
you need to Select a 
Unit ID, which must correspond to the unit number that this particular 
ZipNet Terminal is set to (see your ZipNet Terminal manual for details 
on how to do this).  Note that every unit at a particular location must 
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have a unique Unit ID – you can’t have more than one unit with the 
same Unit ID at the same location. 

Finally, you need to set the Location that this unit is associated with.  
Note that only locations that have already been defined can be selected, 
which is why you need to set up your locations first. 

If you need to temporarily stop the ZipNet Anywhere polling program 
from communicating with a particular unit for some reason, you can do 
so by checking the Disable Unit box.  If this box is checked, this unit 
will no longer be polled. 

Once you’ve finished defining a unit, press the OK button to save the 
unit, or press the Cancel button if you don’t want to save it.  You can 
then define any other units needed for your application as required. 

Setting up Schedules 
The next step in configuring ZipNet Anywhere is to define when you 
want the program to poll the locations that you’ve set up.  To set your 
polling schedules, select the Scheduler tab to bring up the screen 
below: 

To define a polling time, you can either right click in the yellow section 
of this screen, then select Add Schedule Entry, or select New 
Schedule Entry from the Insert menu.  This will bring up the screen 
shown on the next page. 
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The first thing you need to do is select the Poll Location that this 
schedule entry refers to, then select whether to poll at a Specific Time 
or Periodically. 

If the periodical poll option is selected, you can choose from the periods 
available in the Poll Every section of the screen, while if the specific 
polling time option is selected, you can set the time for the poll in the 
Select Time To Poll section of the screen. 

You can set the days that this schedule entry applies to in the Poll Units 
On These Days section of the screen. 

Finally, if the Set Time Only checkbox is set, ZipNet Anywhere will 
poll the units at this location, but only set the time on the units and not 
download the data from them. 

If you need to temporarily suspend a scheduled poll for some reason, 
you can do so by checking the Disable This Entry box.  If this box is 
checked, this schedule entry will be ignored. 

Once you’ve finished defining a schedule entry, press the OK button to 
save the entry, or press the Cancel button if you don’t want to save it.  
You can then define any other schedules needed for your application as 
required. 

Note that the “Poll Every” times are referenced to midnight – if you 
select every four hours, polls will occur at 04:00, 08:00, 12:00, and so 
on.  If you select every ten hours, polls will occur at 10:00 and 20:00 
only. 
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Storing the Output File 
The final step in configuring the ZipNet Anywhere polling program is 
to tell it what to do with the data it has collected. 

If you’re using ASP’s ZipNet TimeSheet program to process the 
collected data, probably the most convenient place to store the data is in 
the ZipNet TimeSheet installation folder on the computer that ZipNet 
TimeSheet is running on. 

Press the Setup toolbar button, or select File Setup from the File menu 
to bring up the screen shown below. 

For use with ZipNet TimeSheet, select the All In One File option, then 
specify the filename and location in the Destination File field. 

To specify the filename and location, you can use either a full UNC 
filename, where you specify the name of the machine, drive and folder 
that the file is to be written to (as shown above), or you can use a 
mapped drive letter (for example, s:\asp\ziptime32\virtual.txt).  If you 
don’t understand these terms, or you don’t know which option is most 
appropriate for your network, you should contact your network 
administrator or computer support people. 

Regardless of where you save the collected data, the most vital point is 
that the ZipNet TimeSheet program has to be configured to look for the 
file in the same place. 

If for some reason ZipNet Anywhere can’t immediately save the data it 
collects to the destination file (for example, if your PC network is 
down, or the computer you’re trying to save the data to is turned off), 
ZipNet Anywhere will hold the data until it is again able to send it to 
the destination file over your LAN. 

 



ZipNet Anywhere V1.0 

 

9

Setting Up ZipNet TimeSheet 
The final configuration step is to set up the ZipNet TimeSheet program 
to use the data that the polling program collects. 

From ZipNet 
TimeSheet’s main 
screen, select 
Download from the 
Setup menu, after 
which you’ll be 
presented with a 
screen as shown on 
the right. 

In the Scanner List 
section, set the Type 
to Virtual ZipNet 
and the IN/OUT 
Setting to None 
Kept.  At the bottom 
of the screen, set Download Every to whatever period you decide is 
appropriate.  You can give this configuration a Name if you like – in 
the screen above, we’ve called it “Polling Program”. 

If you’ve set up ZipNet Anywhere as described in the previous section, 
you should leave the Virtual ZipNet File name set to the default of 
virtual.txt in the ZipNet TimeSheet installation directory.  Otherwise, 
you need to ensure that ZipNet TimeSheet is looking for the file in the 
same location that ZipNet Anywhere is set to. 

Running ZipNet Anywhere 
The ZipNet Anywhere polling program is designed to be configured 
once and then left to do its job. 

To create a “set and forget” system, you may want to put ZipNet 
Anywhere in the Startup group of your computer so that it runs every 
time you start the computer, and select the “Hide On Startup” option to 
hide the program as an icon in your system tray, next to the 
time at the bottom right of your screen, as shown on the 
right. 

To open the program again, right click on the icon in the system try and 
select Open.  And to hide it back into the system tray, just press 
the minimize button at the top right of the program window (the 
underline-like button on the left, as shown on the right). 
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Copyright, License & Limited Warranty 
The ZipNet Anywhere program is a proprietary product of ASP 
Microcomputers and is protected by copyright laws.  Copyright laws 
prohibit making additional copies of the software for any other person. 

ASP Microcomputers grants the purchaser of this software a license to 
use one copy of the software on a single-user computer, but not to sub-
license, rent or lease the software.  You may permanently transfer your 
license to use the software by passing the original disk and manual to 
another person and simultaneously destroying all copies of the software 
or documentation in your possession.  Such a transfer terminates your 
license to use the software.  The new possessor of the software accepts 
a license to use the software on the basis expressed here on first use of 
the software. 

ASP Microcomputers undertakes that the software will perform 
substantially as described herein, and will correct “bugs” notified by 
licensed users within a reasonable time.  Should such “bugs” not be 
correctable, the only remedy available to you will be return of the 
software for refund.  This warranty is in lieu of other warranties express 
or implied including but not limited to the implied warranties of 
merchantability and fitness for purpose.  In no event will ASP 
Microcomputers be liable for damages including loss of profits or other 
consequential damages arising out of your use or inability to use the 
software. 

This limited warranty gives you specific legal rights.  Some states give 
other rights and/or do not allow excluding or limiting implied 
warranties or limiting liability for consequential damages.  
Accordingly, the above limitations/exclusions may not apply to you.  If 
any provision of this agreement shall be void unlawful or unenforceable 
then that provision shall be severable without affecting the validity of 
remaining provisions.  This agreement is governed by the laws of 
Victoria, Australia. 
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